
   Using Photoshopʼs Soft Proof Setup.
One of the most powerful and useful features in Photoshop 6.0 and 7.0 is the accurate soft proofi ng capabilities. 
Soft proofi ng is a term that describes using a display to produce a preview on screen that accurately shows what 
the printed output of a fi le will look like. This takes a great deal of guesswork out of editing images for fi nal 
output. 

For soft proofi ng to work correctly, a few areas need to be addressed. First, the accuracy of any soft proof 
depends on accurate ICC profi les for both the display and for the output device the user hopes to eventually 
send their fi les to. If the monitor isnʼt properly calibrated and profi led, there is no way in which the preview of 
fi les will be correct. Consequently, if the output profi le for the device a user hopes to soft proof isnʼt accurate, 
there is no way the preview will be an accurate indication of the printed output. Keep in mind that a display is 
glowing phosphors while a print is refl ective and MUST be viewed under proper lighting conditions (a D50 
lightbox). Nonetheless, when setup properly, Photoshop can provide a very accurate on screen indication of 
what a fi nal output will look like! 

Why soft proof? When should one use the feature? Just because a user is working on an RGB fi le that may be in 
a Working Space like Adobe RGB 1998, doesnʼt mean that what they are seeing on screen has any relationship 
to what output device will produce. A soft proof is necessary to predict the fi nal output and will allow the user to 
edit the fi le based on those conditions. RGB Working Spaces are useful for editing and archiving a fi le that may 
be used for multiple printing needs. However, at some point in time, a user will want to see how that fi le will 
appear when output without having to actually print the fi le. Here is where the soft proofi ng in Photoshop comes 
into play. At a certain time in the editing process, the fi le will appear acceptable to the user in the RGB Working 
Space. At this point, the user may now wish to see how the fi le will appear to output on their Epson printer. One 
would setup a soft proof for the Epson printer and the preview on screen may radically change based on that 
single output devices behavior. The fi le is still in the pristine RGB Working Space; it is only previewing as it 
will appear when printed. The user may wish to continue to edit the fi le so it appears on screen as they prefer, 
based on the preview for the Epson printer. Before altering the fi le based on a single output device, it is a good 
idea to make a copy of the fi le (use the Image->Duplicate command). Then edit this fi le while in the RGB 
Working Space while being previewed based on the soft proof to the desired printer. The numbers in the fi le are 
being altered to insure acceptable output to that one Epson printer and therefore it is a good idea to do this on a 
copy of the original RGB fi le (the archive). As we will see, using Adjustment layers can be handy for creating 
multiple “corrections” per image for each output device. 

Let us examine the pre-existing items in the Proof setup menu before we make custom settings.  Under the 
“View Menu” select “Proof Setup.” While holding down the mouse, notice the menu options. Below “Custom…
” there is a number of submenuʼs beginning with “Working CMYK.” If that menu item is selected, a soft proof 
of the currently selected CMYK output profi le loaded in the Color Settings will be provided. For example, if 
the current Color Settings are set for U.S. Prepress defaults, the SWOP Coated v2 would be the CMYK profi le 
loaded and that profi le would be used if one selected “Working CMYK.” Below “Working CMYK” are several 
menu options that allow the user to see a soft proof of individual color channels that make up the CMYK 
process. Picking “Working Magenta Plate” would show on screen the soft proof of just that channel. It is 
important to know that when picking “Working CMYK” that the profi le being used is the one currently loaded 
in the Color Settings.

Below CMYK, options for soft proof are three methods of viewing fi les as if they were being seen outside an 
ICC savvy application. For example, “Macintosh RGB, Windows RGB or Monitor RGB” are each different 
ways to examine a fi le without using Photoshopʼs “Display using Monitor Compensation” features**”. 
That is, you can see what a fi le would look like in an application that doesnʼt know how to recognize the 
embedded profi les in a current open document and properly preview it with a display profi le. Opening a fi le in 



“Adobe RGB 1998” outside of an ICC savvy application usually results in a preview where the colors appear 
unsaturated. The colors do appear correct in Photoshop since it operates correctly with fi les that have embedded 
profi les. Using the “Macintosh RGB” would show a user what a fi le looks like on a Mac (using a 1.8 display 
gamma) outside of an ICC savvy application like most web browsers. “Windows RGB” does the same but uses 
a 2.2 display gamma. These two options might be useful for someone that wants to see how fi les will appear 
on different platforms outside of smart, ICC savvy applications like Photoshop. This is a good indication of 
how poorly and inaccurately fi les will appear and it is useful to show how much better it is to use ICC savvy 
applications when viewing images accurately is important. “Monitor RGB” produces the same function but 
uses the actual users ICC display profi le to produce the previews (without regard to the documents embedded 
profi le). This shows how a fi le will appear on a users machine outside of Photoshop (or any non ICC savvy 
applications). 

**For more information about “Display Using Monitor Compensation” and other Photoshop related color 
architecture, please see the PDF “PS5 Color Management” on the digital dog web site. 

To test this series of features out and see why non ICC applications can produce poor and inaccurate color, try 
this:

1. Open a fi le in a Working Space like “Adobe RGB 1998” or even better, “ProPhoto RGB”. You may need 
to actually take an existing fi le and, using the “Convert to Profi le” command, convert the document into 
one of these wider gamut colorspaces. 

2. Select the “View Menu” then go to the “Proof Setup” submenu and try viewing the fi le in “Macintosh 
RGB”, Windows RGB” and “Monitor RGB.” 

3. The fi le should appear desatureated compared to how it appeared with these soft proof options off. The 
previews being seen are similar to how this fi le would appear outside of Photoshop or any ICC savvy 
application.  Bottom line is the previews are not a correct indicator of how the fi les really should appear. 

The real power of the soft proof is when using the “Custom…” submenu found in “Proof Setup.” Here a user 
can pick any ICC output profi le that resides on their machine and save these settings to quickly produce a soft 
proof. To see how this all works, lets do a step by step and setup a soft proof. First, open a fi le (for this tutorial, 
open the “Printer Test File. jpg” fi le that can be downloaded from the Digital Dog web site).



1. Under the “View” menu, select “Proof Setup” and then the “Custom…” submenu. The dialog seen in 
fi gure one will appear (the actual profi le seen may not match what you see in this fi gure; donʼt worry). 

2. Click on the “Profi le:” popup menu and notice that all the ICC profi les installed on listed but grouped in 
such a way that all the “Working” profi les found in the color settings (Working RGB, CMYK and Gray). 
Below that are all the profi les that Photoshop has installed on a users machine, followed by all additional 
profi les that are in on the users machine (grouped by colorspace). Since Photoshop has installed various 
profi les, pick “Euroscale Coated v2” which is a CMYK output profi le. 

3. Notice that the background “Printer Test File. jpg” image actually changes its appearance as Photoshop 
produces a soft proof with this profi le! Notice a popup menu called “Intent” where one can see the effect 
of the various rendering intents on the preview. Pick “Relative Colorimetric.” 

4. For this part of the tutorial, we will save these settings. Click on the “Save…” button and when the Save 
dialog appears, name this “Eurocscale coated RelCol” and click the “OK” button. Photoshop will default 
to save this setting fi le in the right location (the Proofi ng Folder) and as a .psf fi le. One can save this 
anywhere but it is recommended that these .psf fi les be saved in the Proofi ng folder. Notice there is a 
“Load” button where one can locate and reload any saved .psf fi le. 

5. Click on the OK button to dismiss the Custom Proof Setup. Select the “View” menu, then the “Proof 
Setup” Submenu and notice that a setting by the name of “Eurocscale coated RelCol” is now found at 
the bottom of the sub menu and can be selected at any time. There should be a check mark next to this 
name, indicating that this is the currently selected Proof Setup fi le to be used for Soft Proofi ng. 

6. To turn the soft proof on and off, select the “View Menu” and then move down and select “Proof 
Colors” or better, use the Command Y key command. Toggle this on and off while examining the 
“Printer Test File. jpg” image and you will see the preview change. The soft proof using the Euroscale 
Coated v2 profi le should look a bit muted. This is because “Printer Test File. jpg” has saturated colors 
(especially the spectral gradient) that is out of gamut of the Euroscale Coated v2 output profi le! 

When the soft proof is in operation, notice that the fi le name at the top of the document window will change 
from the fi le name (“Printer Test File. jpg”) to “Printer Test File. jpg (zoom ratio) (CMYK/ Eurocscale coated 
RelCol).” This is an important indicator that the soft proof is on so keep this in mind. 

When building a custom soft proof, it is usually a good idea to make at least two: one for a Perceptual rendering 
intent and one for a Relative Colorimetric rending intent.  This allows one to pick which intent they will want 
to use when they eventually convert the fi le. It also shows how rendering intents can affect the colors (and 
often density) of the fi le. When the time comes to do a conversion using the profi le being used in the soft proof, 
simply pick one that produces the best/preferable preview! No single intent is always the correct intent to use. 
The soft proof makes determining which intent to use fast and easy. Pick the intent and then, if necessary, begin 
to edit the fi le based on the soft proof. 



Advanced options:

Preserve Color Numbers:
Going back the Custom Proof Setup, there are some options, which should be discussed. The fi rst is a neat 
little check box named “Preserve Color Numbers” which doesnʼt make a great deal of sense until explained. 
What this check box does is show the user what the image would look like printed without fi rst using the 
output profi le selected in the “Proof Setup”. In other words, if I have a fi le in “Adobe RGB 1998” going out 
to an Epson 2200 and Iʼve selected one of the Epson output profi les, clicking on this check box would show 
me how ugly the image would appear. “Adobe RGB 1998” isnʼt close to the correct set of numbers needed for 
this printer. If I simply send the fi le to the printer, this is how awful it will print. With the check box off, Iʼm 
seeing how the fi le would look if I fi rst converted from “Adobe RGB 1998” to the Epson printer profi le. Is this 
checkbox useful? Sometimes it is. First, it illustrates the need for output profi les and why we must convert from 
the Working Space to a Print Space using a profi le. For those working with untagged fi les or fi les that are in an 
output space (CMYK specifi cally), it is useful to see what the fi le would look like if the current set of numbers 
were simply sent to the printer “as is.” For example, if someone provides a fi le in “SWOP Uncoated v2” but the 
fi le will be output to a device where “Eurocoated” v2 is the behavior of the device. By un-checking “Preserve 
Color Numbers”, a soft proof is produced showing what the output would look like if those numbers from 
SWOP were sent directly to this output device that prints as Eurocoated!

Preserve Color Numbers will be grayed out unless the current colorspace and the output space are the same. 
In other words, if the fi le is in “Adobe RGB 1998”, and I pick “SWOP Coated v2” in the Proof Setup Profi le 
Popup, Preserve Color Numbers is grayed out. However, if I pick an RGB output profi le (Epson 2200 Luster), 
then the check box will be available for use. I can see what the fi le would look like going to the Epson since 
both fi le and output profi les are the same colorspace (RGB). 

Use Black Point Compensation:
 This is new in Photoshop 7.0. It is only mildly useful. Since it is recommended that conversions using profi les 
be done in Photoshop and the default should be to always use “Black Point Compensation,” this check box 
has little value. However, it does show on screen what would happen if Black Point Compensation is NOT 
used when converting a fi le. If images are to be converted outside of an Adobe product that supports “Black 
Point Compensation” (like using a RIP), one can see how the image will convert without this option. For more 
specifi cs on Black Point Compensation, see the PDF on www.digitaldog.net. 

Simulate: Paper White/ Ink Black:
This is a handy option for the soft proofi ng of fi les and when used correctly can produce much more accurate 
screen to print matching. With these options not checked, Photoshop is producing a Relative Colorimetric 
rendering with Black Point Compensation to the screen. This means that when a fi le contains a very dark value 
(say 0/0/0), Photoshop is attempting to preview the image and producing as dark a preview for these values 
as possible on the display. The opposite is true for “Paper White”. The display is producing as high intensity 
as possible to “simulate” white. However, this soft proof is overly optimistic! The white of printed-paper and 
the black of ink on paper arenʼt really close to this intensity. Therefore, with “Paper White” check box on, 
Photoshop attempts to simulate the white of the actual paper and not attempting to produce the brightest white 
the actual display is capable of producing. Checking “Ink Black” turns off Black Point Compensation in the 
simulation-to-monitor transform, and thus shows you somewhat weaker and muddy black (assuming the profi le 
for what youʼre simulating has an accurate black point rather than mapping to 0/0/0 which isnʼt really correct). 

When these check boxes are on, the actual soft proof is usually much more accurate to the printed piece viewed 
nearby on a D50 light box. The black on screen is more accurately previewing just how dense the black ink on 
paper really is. The same with paper white. The bad news is that when a user toggles on these check boxes, they 



see their nice snappy image on screen get muddy! The process of seeing the preview change before your eyes is 
both sobering and usually is so intense that one really should not watch the conversions take place! As odd as it 
sounds, the best thing to do is have a series of saved soft proof settings with these options, then select them and 
turn away as the preview updates. After a few seconds of not viewing the original preview, the appearance of 
this “muddy” image will not be apparent. The soft proof should be much more accurate to the printed page. It is 
just dangerous to watch the Paper White/Black Ink preview “kick in.” I usually make a set for one output profi le 
that has the Paper White/Black Ink both on and off with the two rendering intents selected for each set. So I will 
have four saved settings per output profi le. For most editing, I may work with the check boxes OFF and then 
toggle them on to see how the image appears, and perhaps edit based on that preview. 

Note that whenever one selects the “Paper White” check box, the “Ink Black” will always be on as well. You 
canʼt have “Paper White” without “Ink Black” but you can pick just “Ink Black”. Generally, one will want both 
check boxes on but in some cases, depending on the profi les and how accurately they refl ect these two ends of 
the tonal scale, just “Ink Black” can be a good option. Play with these options and see if the soft proof to print 
matching really is better or not. 

Workfl ow:
The soft proof settings are a good way to work when the time comes to edit the fi le based on the specifi c output 
device one will use but keep in mind that the data is still in the RGB Working Space. This data should be kept 
unaltered since editing based on another output device may be necessary in the future. One can duplicate the fi le 
and begin editing and eventually convert to the output space but always be sure to save this as a separate fi le. 
The other option is to use Adjustment Layers! Name the Adjustment Layer for the output device the edits are 
going to be used for and just be sure that all the other adjustment layers (for other output corrections) are turned 
off. Its possible to have a fi le in an RGB Working Space and have half a dozen different adjustment layers all 
specifi cally created for a particular output device. Edit using these layers while viewing the soft proof so that 
the adjustment is tailored to product the visual effect you wish. Keep in mind that some RIPʼs or output devices 
may not be able to accept a layered fi le. 

The bottom line here is to use specifi c custom soft proof settings to preview on screen how the fi le will appear 
to any given output device. Edit the fi le if necessary to produce a preview that will result in output you prefer. 
Keep in mind that specifi c rendering intents can be previewed so that when time comes to do a conversion, the 
rendering intent to use isnʼt a guessing game. With accurate display and output profi les, and a good D50 light 
box, Photoshop will provide excellent soft proofi ng which eliminates the need to print the fi le multiple times 
with multiple rounds of edits. 
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